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MATERIALS 

SpaceStat_Tutorial_Detecting_Clustering.SPT  

ESTIMATED TIME 

30 minutes 

OBJECTIVE 

You will detect possible clustering of breast cancer cases and controls in simulated data.  You will 
learn how to evaluate the presence of case and control changes through time and how to assess the 
global and local clustering of residential histories using Q-statistics.  You will also look at the 
sensitivity of your results to k, the number of nearest neighbors considered. 

ABOUT THE DATA AND RESIDENTIAL HISTORY CLUSTERING 

The SpaceStat project for this tutorial contains simulated data for Michigan.  The data represent the 
‘residential life histories’ of cases of bladder cancer and controls.  A ‘residential life history’ of a 
person consists of the locations where a person lived over the course of their life.  For example a 
study performed in 2010 might question 1000 cases and controls to determine where these 
individuals have lived since birth. 

There are several challenges with trying to ascertain clustering in a disease like breast cancer.  
Traditional clustering that takes into account geographic information is problematic due to the long 
latency period of cancer and mobility of modern individuals.  People may have moved many times 
since being exposed to an increased risk of cancer.  Also, study participants may have lived near an 
increased risk at different periods of time, never overlapping temporally in their location of 
residence. 

Clustering aims to find increased risks of cancer that occur either geographically or temporally or 
both.  Q-statistics offer a family of statistics that examine clustering of several different types.  There 
are four main indicators calculated in Q-statistics: the global Q, Qi, Qt, and Qit.  The global Q 
evaluates the average clustering for all individuals through time.  Qi evaluates the clustering around 
an individual over his or her life course.  Qt assesses global clustering at a given time and is 
analogous to traditional case/control clustering methods such as the Cuzick and Edwards statistic.  
Qit evaluates the clustering around an individual at a given time.  More detailed descriptions of these 
statistics can be found at the end of this tutorial. 

 

http://www.biomedware.com/subdomains/biomed/files/tutorials/QStatistics/SpaceStat_Tutorial_Detecting_Clustering.spt
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STEP 1: OPEN THE STARTING PROJECT 

The SpaceStat project containing these different datasets has already been created for you. 
Navigate through the menus to File-> Open Project or click the Open Project button as shown 
below. 

 

Using the Open Project button 

 

You can download this project to use from the following link: 

                       SpaceStat_Tutorial_Detecting_Clustering.SPT 

STEP 2: MAPPING THE RESIDENTIAL HISTORIES 

Mapping the residential life histories of cases and controls is a good first step to your clustering 
analysis.  To create a map of the data, click the ‘Map’ button on the SpaceStat toolbar (the ‘Map’ 
button has a globe icon).  Replace the ‘Map name’ with ‘Residential life histories’.  Select ‘ccid’ for 
the ‘Fill color dataset’.  The ccid field indicates whether the individual is a case (value of 1) or a 
control (value of 2).  The default options are fine for the other options.  Compare your settings 
against the dialog below and click the ‘Ok’ button. 

 

Create map dialog 

http://www.biomedware.com/subdomains/biomed/files/tutorials/QStatistics/SpaceStat_Tutorial_Detecting_Clustering.spt
http://www.biomedware.com/subdomains/biomed/files/tutorials/QStatistics/SpaceStat_Tutorial_Detecting_Clustering.spt
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Now there are a few issues with the map.  First of all, you may be surprised to see only a single point 
in the middle of the map, but this is because this is when the first individual was born.  No others 
were alive yet in 1924.  If you animate the map by pressing the play button on the map toolbar you 
will see other people appear soon. 

The default map display leaves a bit to be desired.  In this case, we would like to be able to 
differentiate easily between cases and controls.  Enter the Map Properties dialog by clicking on the 
‘Map Properties’ button (the button on the map toolbar with a book for an icon).  First you may 
notice that the cases are shown in blue and the controls in red.  This is a bit counterintuitive as 
usually we associate cases with red.  Double-click on the blue square indicating the cases (ccid value 
of 1).  In the color dialog that opens up, click the ‘Set color’ button and choose a red color.  Click 
‘Ok’ to return to the Map Properties dialog.  You could change the control color to something else, 
such as blue, but since we are going to use a special symbol for controls, you don’t need to do this. 

In the Map Properties dialog, click on the ‘Point Symbols’ tab near the top center of the dialog.  
We’d like to specify symbols for each value.  Make sure to click the ‘ccid’ entry in the Datasets on 
the left.  This specifies that the symbols depend on this data field.  Make sure that ‘Classified’ is 
selected in the ‘Symbol mode’ dropdown list.  Double-click the circle in the first row of the table 
(ccid value of 0).  Select the cross symbol from the dropdown and click ‘Ok’.  This will make all 
controls shown by the cross.  Double-click the circle in the second row of the table (ccid value of 1).  
Select the filled circle symbol from the dropdown and click ‘Ok’.  The image below shows the Point 
Symbols tab after you have made these changes. 

 

The Point Symbols tab 
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Now click ‘Ok’ on the Map Properties dialog to apply your changes.  If you animate the map by 
pressing the ‘Play’ button on the map toolbar, you should easily be able to tell which individuals are 
cases and controls.  The screenshot below shows the map at one point in time. 

 

 

The customized map 

STEP 3: MAKE A HISTOGRAM OF THE HISTORICAL PRESENCE OF CASES AND CONTROLS 

The last visualization you will create before the clustering analysis is a histogram.  Click the 
‘Histogram’ button on the SpaceStat toolbar.  The Histogram button is the third icon in the second 
group of icons and looks like a series of vertical bars. In the dialog that opens, select the ccid dataset 
in the dataset dropdown list.  Click the ‘Ok’ button to create the histogram. 

First select the Window->‘Time-synchronize all views’ option from SpaceStat’s main menus.  This 
will force the two visualizations to display data at the same time.  Next, select the Window->Tile 
option to arrange the two visualizations so that you can easily see both (you may want to maximize 
SpaceStat before you perform this step).  You may also want to close the Graph Statistics panel on 
the histogram to gain more room for the visualizations.  Now you can animate the views and explore 
the visualizations.  Notice how the numbers and locations of cases and controls changes as time 
progresses. 
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Visualizations of the case/control residences 

STEP 4: EVALUATE CLUSTERING OF THE RESIDENTIAL HISTORIES 

Using static clustering approaches such as the Cuzick and Edwards test on dynamic data can lead to 
false findings since the results are highly sensitive to when you observe the system.  Instead an 
approach that accounts for residential mobility like the local and global Q-statistics is needed.  The 
Q-statistics evaluate whether a given case tends to have other cases as its k-nearest neighbors over 
its residential history as compared to the distribution of controls. 

Select Methods->Case control methods->Jacquez’ Q from the SpaceStat main menu.  This will start 
the Task Manager pane on the right side of the SpaceStat interface.  The Case/control dataset 
selected by default should be the ‘ccid’ dataset from the ‘breast cancer’ geography.  Select this if it is 
not already chosen.  For this analysis, keep the default of 99 randomizations.  This will give the 
ability to discern p-values of 0.01 since the p-value is calculated as (number of randomizations 
where the test statistic is larger than the observed+1)/(number of randomizations+1).  You will 
begin with 15 nearest neighbors (k=15) as recent simulation results have found this to be a good 
starting point for nearest neighbor determination.  The default start and end time of the entire 
period are fine as are testing for the number of significant statistics and 99 randomizations for 
num(Q*) distributions.  In this first analysis, you should be using all of the default Input settings and 
the dialog options should look like the following screenshot. 
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Input settings for the Jacquez’ Q method 

Click the Exposure period vertical tab (you can click anywhere on the line with the gray circle and 
the ‘Exposure period’ label).  Here you could specify a model of when participants are sensitive to 
exposures that might cause disease, for example vulnerable at certain ages.  The methods all 
automatically weight by duration, adjusting for how long people lived at each residence.  Here the 
default of a ‘Continuous’ exposure period over the entire time period is fine.  Click the Output 
vertical tab.  Choose an output folder name of ‘Q(k=15, N=99)’.  Click the ‘Run’ button at the 
bottom of the Task Manager to begin the calculations. 

 

STEP 5: GLOBAL CLUSTERING RESULTS 

The results of the global clustering tests are reported in the Log view which is the bottom pane of 
the SpaceStat interface by default.  You will need to scroll back to see the results of the analysis you 
just conducted.  The first result should look something like the following (these are results of a 
randomization so your results may vary slightly): 

Most significant Qi cluster: person 99. P value: 0.020000 
Second most significant Qi cluster: person 90. P value: 0.020000 
Third most significant Qi cluster: person 74. P value: 0.020000 
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Qi assesses clustering over the life course of an individual.  This lists the 3 people with the most 
significant clustering for Qi.  The next results listed should look like the following (these are results of 
a randomization so your results may vary slightly): 

Most significant Qt interval: [14 May 2004, 17 May 2004). P value: 0.010000 
Second most significant Qt interval: [17 May 2004, 18 May 2004). P value: 0.010000 
Third most significant Qt interval: [18 May 2004, 24 May 2004). P value: 0.010000 

Qt is similar to the Cuzick and Edwards statistic and assesses global clustering at a given time.  These 
results list the time intervals with the most significant clustering.  The final set of results should look 
like the following (these are results of a randomization so your results may vary slightly): 

Global Q: 24632.550685 case-years. P value: 0.570000 
Normalized global Q: 6.456132 cases. 
The number of significant Qi statistics(10) was not significant (P=0.150000) 
The number of significant Qt statistics(48) was not significant (P=0.070000) 
The number of significant Qit statistics(1308) was significant (P=0.020000) 
The number of significant Qit's which were also part of significant Qi's(892) was 
significant (P=0.020000) 
The number of significant Qit's which were also part of significant Qt's(475) was 
significant (P=0.030000) 
The number of significant Qit's which were also part of significant Qi's and Qt's(125) was 
significant (P=0.050000) 

The Global Q statistic assesses the overall clustering for all individuals through time.  The number of 
significant statistics assess whether the number of local statistics for Qi, Qt, and Qit as well as the 
possible set intersections are significant.  A detailed description of these local statistics is given in at 
the end of this tutorial in an appendix containing a Venn diagram and a table of the sets.  Here you 
can learn about which patterns are related to various causal processes. 

 

STEP 6: SENSITIVITY TO K 

The number of nearest neighbors, k, used in the analysis was arbitrarily chosen as 15.  Choosing k 
arbitrarily is not recommended; instead we recommend an exploratory approach for determining a 
good k.  Explore a range of k, for instance from 10-20 and note the p-value of the Global Q statistic 
for each k value. You can make a graph of the p-values as a function of k or just record the values.  
Select the k that yields the lowest p-value and perform the clustering analysis with that k.  For the 
sake of time, we did not include this entire process in the tutorial, but feel free to perform this 
exercise on your own. 
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STEP 7: MAPPING THE LOCAL CLUSTERS 

Select the dataset ‘Qit P value (k=15)’ from the Data view in the left pane of the SpaceStat interface 
(If you examined the sensitivity to k, choose the results from the test that had the lowest p-value for 
the Global Q rather than k=15.).  Right-click on this and choose Create Map from the context-
sensitive pop-up menu.  Confirm the default settings and click the ‘Ok’ button to create the map.  
The default map coloring isn’t appropriate for these results, so press the Map Properties button 
from the map toolbar (the button has an open book icon). 

The Point color tab should be opened and the Qit P value (k=15) dataset should already be selected.  
Change the color mode to ‘Classified’ in the color mode dropdown list.  Change the number of 
classes to 3.  Next go through the classes and modify the range of p-values to have the following 
Minima and Maxima: 0 to 0.05, 0.05 to 0.1, 0.1 to 1.0.  Next double-click on the Fill color square 
for each of the classes, click the Set color button, and choose the following colors: red for 0 to 0.05, 
orange for 0.05 to 0.1, and blue for 0.1 to 1.0.  This will create 3 color classes based on p-value. 

 

Creating 3 classes in the Map properties dialog 

You can click on the ‘Point size’ tab and use the same approach.  For the following visualization we 
created 2 size classes with a width of 16 for a class from 0 to 0.5 and a width of 8 for 0.05 to 1.0.  
Click the ‘Ok’ button to confirm your changes to the map.  Animate the map using the ‘Play’ button 
on the map toolbar. 
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Map of local Qit values at May 1982 

ABOUT THE SIMULATED DATA 

In this dataset, all individuals were first randomly assigned case/control status.  Next the individuals 
in the bottom left of the map in September of 1985 were all made cases (there were 5 that had 
been controls) to simulate a strong cluster.  Your results should detect this cluster and you can 
watch the mobility of these individuals in time if you select them and animate the map. 

DETAILED INFORMATION ON THE Q STATISTICS 

The number of significant Q statistics can be represented and designated by the following Venn 
diagram: 
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Significant Q statistics 

The following table adapted from Sloan et al. 2012 described in detail each of the set designations 
from this Venn diagram and example disease etiologies that can give rise to these patterns: 

Cluster set Description Pattern Example etiology 
𝑸�𝒊𝒕 Local case-time 

clustering 
Cases (i) that at times t have a 
significant number of nearest 
neighbors that are cases 

Infectious: Contagious process such that infection spreads from a case 
to its susceptible neighbors.  Vector-borne disease process such that 
individuals in specific areas have increased risk of infection. 
Chronic (e.g. cancer):  Increased cancer risk for individuals residing in 
local areas over a defined time period.  Duration of elevated risk must 
be sufficiently long relative to the duration of time individuals live in the 
affected areas (e.g. exposure time must be sufficient to induce disease 
response). 

𝑸�𝒊 Clustering over the 
life course 

Cases (i) who, over the study 
period, have a significant 
number of nearest neighbors 
that are cases 

Infectious: The “typhoid Mary” or “super-spreader” process, whereby 
case (i) (the super-spreader) is infectious over the study period and 
transmits infections to nearest neighbors. Vector-borne disease process 
where case i has behaviors that enhance the vector life-cycle (e.g. 
provides water receptacles such as empty cans and tires for container-
breeding mosquitoes).   
Chronic (e.g. cancer): A process whereby neighbors of case i have 
increased cancer risk and such risk is elevated over the life course of 
case i.  An example would be behaviors that increase cancer risk for 
others nearby such as second hand smoke. May also arise when groups 
with elevated risk tend to move or remain together over their life course 
(e.g. familial groups with common genetic and/or behavioral risk 
factors). 

𝑸�𝒕 Temporal case 
clustering 

Large-scale spatial clustering of 
cases at time t.  Clustering of 
cases relative to controls is 
significant at time t when all 
cases and controls are 
considered. 

Infectious:  Infection outbreak such that the infection impacts a large 
portion of the study population; endemic phase of infection with 
multiple local outbreaks. 
Chronic (e.g. cancer):  Chronic disease with an underlying infectious 
etiology (e.g. viral hypothesis of cancer) that impacts a large portion of 
the study participants;  Disease risk mediated by environmental 

All Qit  
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exposures that vary across the study area such that risk is elevated for a 
large number of study participants.   Duration of elevated risk must be 
sufficiently long relative to the duration of time individuals live in the 
affected areas (e.g. exposure time must be sufficient to induce disease 
response). 

𝑨� 𝑄�𝑖𝑡 ∩ 𝑄�𝑖 Locations and times when cases 
with significant clustering over 
their life course are members of 
a geographically localized 
cluster.   
Includes both ephemeral and 
persistent clusters. 

Infectious: Local geographic foci of periodic infections with long 
infectious periods from which some of the infected and infectious cases 
move away.    Mobile infectious individuals infect others over their life 
course, leading to an elevated Qi statistic; infectious individuals who 
continue to reside in the area after an infectious period lead to a 
significant Qi statistic. 
Chronic (e.g. cancer): Local areas of persistent elevated risk that are 
sustained for a sufficient period of time that (1) disease risk is increased 
for individuals residing in the local area and (2) the duration of residence 
of cases in the area is of sufficient length to result in a significant Qi 
statistic. 

 𝑩�  𝑄�𝑖𝑡 ∩ 𝑄�𝑡 Local clusters of cases that 
occur over a large portion of the 
study area at time t. 

Infectious:  Large-scale outbreak at specific times, t, that may be 
comprised of local pockets of infection.  For vector-borne diseases this 
can arise when large portions of the study area have suitable vector 
habitat during some parts of the study period. 
Chronic (e.g. cancer): Large scale exposures that occur at a specific 
time(s) t.  An example would be leukemia in response to the Chernobyl 
and Hiroshima incidents. 

𝑪� 𝑄�𝑡 ∩ 𝑄�𝑖 Cases that have clustering over 
their life course and are part of 
large-scale spatial clusters at 
times t. Includes cases whose   
are not statistically significant, 
and some whose   are 
statistically significant. 

Infectious:  Large-scale outbreak at times t with at least some of the 
resulting cases that (i) move together over their life course; and/or (ii) 
remain infectious over their life course and continue to infect their 
neighbors.  For a vector-borne disease this may arise when there is an 
initial large scale outbreak with some of the resulting cases continuing 
to be disease reservoirs (e.g. pathogen sources) whose infection can 
then be transmitted to others in the same family or tribal group 
Chronic (e.g. cancer):  Large scale exposures that occur at a specific 
time(s) t with some of the resulting cases that (i) move together through 
life course or (ii) continue to reside in the affected area over most of the 
study  period. 

𝑫�  𝑄�𝑖𝑡 ∩ 𝑄�𝑖 ∩ 𝑄�𝑡 Cases that have clustering over 
their life course, are part of 
large scale clusters at time t and 
whose local clusters   are all 
statistically significant. 

Etiology is similar to set  , but is restricted to include only those 
individuals that are centers of significant local clustering of cases at 
times t.   For infection, this may be indicative of index cases; for chronic 
diseases this may indicate individuals who are within local pockets of the 
largest exposure. 
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